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1. The “Settings” window

The system provides possibilities to setup system’s parameters to perform different
steps of project processing. The Settings window is used for this.

To open the window choose Service > Settings or click the [ button of the main toolbar.

@ All changes take effect after clicking OK, unless stated otherwise (see Section 19).

2. Settings of windows and marker display

2.1. Settings of windows display

The Windows tab is used to specify display parameters of 2D-windows.

’ ~
. Parameters lﬁ
4 |'Windows [ Windows
Marker (block scheme)
Marker (stereopair) | Automatically open 2D window
Zoom i i
Accelerated transforms Allow pseudo-steren in block 2D-window
Control Separation 0.60 o
. g:zcd:lsil eme Background color in 2D window ]
Raster Multisampling 1 2
Stereo

Limit displayed area in stereopair window

Correlator
DEM Additional indicators in 2D window
TIN Coord lines under marker
4 Grid
Pathway mode | Compass
4 Vectors Grid in block window in stereopair window
Labels
Elevation labels Linear scale
Point numbers Cartographical scale in caption

Coordinate transf
cordinate transtorm Display overlap in stereopair 2D window

Display

Raster Screen resolution (for scale caloulation): 72 | dpi
Orientati -

rientation Font for labels IS Sans Serif. 8
Unde
Backups Set previous marker position in @ new 2D-window
Auto-save Disable intermediate overview display in stereopair 20-window
System

7 i i "
Paths Status panel in 2D window

Move marker to block center on project load

COK l | Cancel

Fig. 1. Settings of 2D-windows

Images block is opened by default in 2D-window when the system starts. Ifit is necessary
to display only the main menu and toolbar (without 2D-window) when the system starts,
which were opened in previous session, set the Automatically open 2D-window
checkbox off.

The system allows to work in pseudo-stereo mode in the block scheme window.




PHOTOMOD 8.0 General system’s parameters (Windows x64)

Pseudo-stereo — is a stereo mode, where orthogonal projection is used for left eye, and
for right eye — parallel projection with some angle to normal line.

In order to turn on the pseudo-stereo mode perform the following actions:
1. Set the Allow pseudo-stereo in block 2D-window checkbox.

2. [optional] To define an angle of projection to normal line, specify the Separation
coefficient.

% A Separation coefficient is equal to survey height/basis ratio. The more precisely Separa-
tion is set, the more accurate Z measurements made in this mode will be.

3. Click OK. To apply changes, close 2D-window and open it again by selecting the
menu item Windows > 2D-window (block).

4. Buttons used to turn on and setup stereomode are added in 2D-window toolbar.
The buttons are the same as buttons in stereopair 2D-window.

In order to specify background color of 2D-windows, click in Background color in 2D-
window area and select desirable color from standard color box.

@ Re-open 2D-windows to apply changes.

The Multisampling checkbox setting allows you to improve the quality of visualization
of objects in the 2D window by using the additional computing power of the video adapter.
Increasing the default value in the appropriate input field improves the detail and quality
of the display of objects in the 2D window, with a possible decrease in system perform-
ance.

§ Multisampling is recommended to be used on workstations equipped with a powerful video
adapter (12 GB and higher), in situations that require the highest possible quality of data display
when demonstrating project materials on the workstation screen.

§ Clear the Multisampling checkbox when performing PHOTOMOD operations that require sig-
nificant system resources.

The Limit displayed area in stereopair window checkbox allows to display in 2D-
window just those parts of layers, which fall into rectangle bounding the stereopair (in
project coordinate system).

The Additional indicators in 2D-window section is used to turn on/off the following
parameters:

» Coord lines under marker — allows to add to the marker guides in the form of red
and green dash lines which are co-directed with the active (main or additional) co-
ordinate axes. The red line is aligned with the X-axis, and the green one is aligned
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with the Y-axis. The guides enable us to assess mutual alignment of the objects on
images.

% The system also allows us to rotate marker cross-hair according to the axes of the additional

(user) coordinate system.

Compass — allows to display in left lower corner of 2D-window axes orientation of
project coordinate system in a marker position;

Grid — allows to display coordinate grid in block window and/or in stereopair win-
dow. In 2D-window a grid is displayed approximately in a marker position height;

Linear scale — allows to display a scale bar (in marker coordinates) and GSD in left
lower corner of 2D-window;

@ In this case, the scale is a aspect ratio of objects on using monitor to real dimension.

% Compass, linear scale and grid are displayed in the Marker layer. In order to hide them (along
with marker), turn off the layer visibility.

Display overlap in stereopair 2D-window — allows to display images overlap area
in stereopair 2D-window (it is calculated using block scheme).

Also the following display parameters are set here:

in the Screen resolutions field is set dpi value for linear scale calculation;

the Font for labels field allows to specify a style of standard labels displaying in 2D-
window. To do this click the button and choose font, size and style of labels from
standard Windows set;

the Set previous marker position in a new 2D-window checkbox allows to save
marker position on image in each new 2D-window relatively to previous window;

the Disable intermediate overview display in stereopair 2D-window checkbox
allows to speed up a transition between stereopairs;

é If this option is enabled there may be some worsening of image visual quality.

the Status panel in 2D-window checkbox allows to display a status panel in lower
part of 2D-window;

the Move marker to block center on project load checkbox is used to place a
marker during project loading to 3D center (including average height) of block. The
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center is calculated if adjustment is available and if the center is located within the
bounds of current block layout.

2.2. Marker settings

The system provides possibilities to choose a marker display style (type, size and color)
for block scheme and for stereopair.

The Windows | Marker (block scheme) and Windows | Marker (stereopair) tabs are
used to do this.

f ™y
. Parameters M
4 Windows -
|Marker (block schemne) |
Marker (stereopair) Type _
Zoom | width (ix) =
Accelerated transforms =
Control Height (pix) o
e
4 Block scheme
St
Eree [] Rotate by C5 axes
Correlator
DEM . Dimension cursor
TIN Number of cirdes 2
4 Grid Flsh -
Pathway mode = Show inner cirdes
ok || cancel

Fig. 2. Marker settings
The Type list allows to choose marker shape. The following shapes are acailable:
* Cross;
» T-shaped marker;
« Aim;
* Rectangle;
* Bold cross;
+ Diagonal cross.

Marker’s width and height are set up in the Width (pix) and Height (pix) fields accord-
ingly. They should be specified in pixels. To go back to default marker size use the
Reset button.

To adjust marker color double click the Color field and choose a color from a standard
color palette.
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To rotate marker cross-hair according to the axes of the additional (user) coordinate
system, set the Rotate by CS axes checkbox.

c This function is available only for a standard Cross-type marker.
To asses the dimensions of various objects using a cursor, set the Dimension cursor
checkbox and set the Number of circles. A step of dimension grid depends on scaling

in the 2D-window. To show inner circles with finer grid (inside the first circle from the
cursor), set the appropriate checkbox.

2.3. Zoom settings

The system provides possibilities of image zoom in 2D-window using hotkeys, and also
various ways of scale presets.

Use the Windows | Zoom tab to setup zoom parameters.

~
. Parameters [&J
4 Windows “| [TZoom
Marker (block scheme)
Marker (stereopair) Zoom text style
Zoom @ 32 150% 1.5x
Accelerated transforms =
Control Hotkey zoom:
Medules Alt+2 B 21
4 Block scheme =
Raster Alt+3 1 31
Stereo Alt+4 1 %1
Correlator C
DEM Alt+5 and "Preset zoom” toolbar button ( Q )
TIN B 1:2
4 Grid —
Pathway mode - u 21
K ] | Cancel

Fig. 3. Zoom settings
The Zoom text style section allows to specify one of zoom displaying style:

» 3:2 - is used to display zoom in the ratio “display on a source image : display on a
screen’;

* 150% — is used to display zoom in percentage;
* 1.5x —is used to display zoom in the ratio “screen image to source image”.

The system allows to use hotkeys to change zoom. Use sliders to setup zoom which
will be applied using the Alt+2, Alt+3, Alt+4 shortcuts.

The Alt+5 shortcut and the & button on the toolbox of 2D-window allow to setup 2
versions of preset zoom.
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3. Performance parameters

To setup the system performance parameters use the Accelerated transforms tab.

1
. Parameters [&J
4 Windows “ | | Accelerated transforms
Marker (block scheme)
Marker (stereopair) = || Useaccelerated approximate coordinate transformation is possible:
Zoom For display For processing
Accelerated transforms Central projection
Control Satelite scanner imagery
Modules ADS 40/30/100 v v
4 Block scheme Interpolation grid step 1 ] 1 =] .
Raster for ADS 40/30/100: = [ =|| pIX
Stereo Precision (except for ADS 40/80/100): 0.10 ] pix
Correlator &
[ CK l | Cancel

Fig. 4. System performance parameters (for ADS project)

The system allows to perform accelerated approximate calculation of coordinates in
order to speed up visualization of images and/or calculations.

To use accelerated calculation set one or multiple checkboxes in columns, that define
for what the calculation is used: For display and/or for For processing, depending on
type of a project:

» Central projection;
» Satellite scanner imagery;

+ ADS 40/80/100.

? Accelerated calculation of coordinates is turned on by default in the system for work with ADS
40/80/100 projects.

The Precision field is used to setup precision of accelerated calculation of coordinates
in pixels.

? Precision of accelerated calculation of coordinates in pixels is not used for ADS 40/80/100
projects.

The Grid interpolation step field is displayed only when working with ADS 40/80/100
projects. It is recommended to decrease value for projects with low camera stabilization,
but the stereopair opens slower and amount of using memory increases.

4. Control parameters

In order to setup parameters of marker control and parameters of stereomode use the
Control tab.
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r 1
. Parameters [&J
4 Windows | Control
Marker (block scheme)
Marker (stereopair) Z movement step B
Zoom u 1 pix. of active zoom
Accelerated transforms
Invert
Control
Modules XY movement step
4 Block scheme Move with step 3 = pix
Raster
Stereo Mouse sensitivity in roam mode
Correlator D
DEM
TIN Invert
4 Grid Autoscroling
Pathway mode Use autoscrolling with border zone 50 | pix
4 Vectors
Labels Automatically adjust parallax in stereo mode
Ele.\ratlon labels Activate with threshold 5 - pix
Point numbers
Coordinate transform Automatically change stereopair
Display Threshold 100 |5 % Stereopair selection mode
Raster
Orientation | For editing @ by block scheme
Undo | For filter and control operations Parametric Settings
Backups
Auto-save Use fixed marker parallax mode as default
System Adjust stereopair slope angle
Paths
Additional stereopair slope angle 0.00 =i
K l | Cancel

Fig. 5. Control parameters

The Z movement step slider allows to specify a step of marker movement by Z axis
in pixels in current scale. In order to increase a step of marker movement, shift the slider
to the right, to decrease the step — shift it to the left.

% The Invert checkbox allows to change zoom direction (in/out) using the mouse wheel.

The XY movement step slider allows to tune work in the roam mode, defines a step
of images moving in 2D-windows of block or stereopair during mouse move.

The Mouse sensitivity in roam mode slider allows to tune work in the roam mode,
defines a speed of images moving in 2D-windows of block or stereopair during mouse
move. In order to speed up the movement, shift the slider to the right, to slow down —
shift it to the left.

ﬁ The Invert checkbox allows to change moving by images or by stereopairs direction (left/right).

A border zone is a distance from boundary of overlap area in percent of image size.
When this distance is reached the automatic scroll of images begins, if in the Auto-
scrolling section the Use autoscrolling with border zone checkbox is set on. Size
of border zone in pixels is set in appropriate field.
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In order to specify a threshold of marker movement by Z, which value will be used to
start automatic adjustment of parallax in stereomode, set the Activate, with threshold
checkbox in the Automatically adjust parallax in stereomode section and specify a
value of the threshold in pixels in appropriate field. This allows to pass from oblique
stereopair to stereopair, for which projection plane (chosen coordinate system) coincides
with stereopair plane.

g In thi§ mode rotation.angle arounq stereopair base line is a_utomatically adjusted during stgreopair
opening, so that epipolar plane is parallel to Z-plane. It is recommended to turn on this mode
when working with oblique stereopairs, for example, acquired by A3 camera (VisionMap)
providing that images of the block were acquired from constant altitude.

c The option has an effect on projects of central projection only.

The Automatically change stereopair section allows to setup automatic changeover
to next stereopair when the border zone is reached. To do this perform the following
actions:

1. Inthe Threshold field specify size of the threshold zone — a distance from boundary
of overlap area in percent of image size.

2. [optional] For automatic changeover to next stereopair when the threshold is reached
during creation/editing of vector objects set the For editing.

3. [optional] For automatic change over to next stereopair when the threshold is
reached For filter and control operations of vectors, contour lines, TIN, and DEM.

% Automatic stereopair changeover when creating points in pathway mode is setup using
corresponding tab.
4. Define the Stereopair selection mode:
* by block scheme — to select next stereopair in a block scheme;
+ parametric — to select a stereopair using specified parameters.

§ Use the Settings button to specify parameters of customized search for stereopair. See
details of parametric search in “Vectorization” User Manual.

§ Is it is impossible to search for the best stereopair using parametric method, a stereopair

from current and next images of the block will be opened.

By default in the system is used the free marker mode. The Use fixed marker parallax
as default checkbox allows to change the default marker mode.

The Adjust stereopair slope angle checkbox allows to to change a slope angle of
stereopair during vectorization automatically. In the Additional stereopair slope angle

10
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field specify correction to omega angles of left and right images during creation of ste-
reopair model in 2D-window of stereopair when processing central projection images.

5. Setup of modules start

To setup parameters of system modules interaction use the Modules tab.

( . Parameters [&y

4 Windows
Marker (block scheme)
Marker (stereopair)
Zoom Orthorectification/Geomosaic 3
Accelerated transforms

| Modules

m | »

Decdmal places

Control Image georeference 3

Modules Import/export, etc. 3

ERE RENS

4 Block scheme

K l | Cancel

Fig. 6. Setup of modules interaction

The Decimal places section allows to define number of decimal places in coordinates
values in the following cases:

* during orthorectification or when working in the GeoMosaic module;
* when saving images georeference;

* during import/export and other operations.

@ The value specified in the Import/export etc. field is used to define number of decimal places
for vector objects attributes labels.

@ The value specified in the Import/export etc. field is used to define number of decimal places
for vector objects coordinates labels.

Use the appropriate fields to specify decimal places.

@ The system supports from 1 to 18 decimal places.

6. Block scheme settings

6.1. Settings of block scheme display
The Block scheme tab is used to setup parameters of block scheme display.

The View section allows to setup the following parameters of block scheme display:

11
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« Trim image edges, % — allows to cut (hide) images edges (the option is used to cut
black fields on images taken by analogue camera, for instance;

+ “Opaque” image frames — allows to display only visible parts of frames according
to order of images and strips in block (set by default);

% Frame of selected images is fully displayed.

» Highlight fill selected images — allows to set semi-transparent fill for selected images;

* Highlight fill selected strips — allows to set semi-transparent fill for all images in a
strip when any image of the strip is selected.

* Rotate block scheme window content (this setting is local for the current pro-
ject) — allows to rotate image for value, set in the Rotation angle field in degrees.

% If the block scheme rotates for 180°, specular reflection occurs on both axes.

ﬁ The parameter is used only for loaded project.

The Make interstrip stereopairs section allows to specify the Minimum images
overlap for forming interstrip stereopairs . It is recommended to set this value not
less than 20%, and for big projects with «good» overlap set the value not less than 40-
50%.

The Form stereopairs parameter allows to choose, which stereopairs with defined
overlap will be formed — all or those which have maximal overlap. When forming stereo-
pairs with maximum overlap could be created insufficient number of stereopairs.

é It is recommended to refresh When forming block using all stereopairs it is recommended to
refresh created block layout (see “Measurements” User Manual).

é The parameter is used only for loaded project.

The Control section allows to setup the following parameters used to work with block
scheme:

* Refresh automatically, if number of images in project less or equal to — allows
to specify maximal number of images, at which a block scheme is refreshed automat-
ically (for example, after editing of tie points or after block adjustment);

* Delete empty strips when deleting images — is used to delete empty strips, which
were created after moving of images on block scheme to new or existing strips (set
by default).

12
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r 1
. Parameters ﬁ

4 Windows | Block scheme
Marker (block scheme)

Marker (stereopair) Display
Zoom Trim image edges, % 0.00 5
Accelerated transforms ~Opaque”image frames
Control
Modules [ Highlight fill selected images
4 |Block scheme [ Highlight fill selected strips
Raster B Rotate block scheme window content
Stereo (this setting is local for the certain project)
Correlator — e e o
80.00
DEM otation angle,
TIN Make interstrip stereopairs
G
Grid (These settings apply only to the loaded project)
Pathway mode - .
Minimum percentage of overlapping 20.00 s
4 Vectors images for forming interstrip stereopairs

Labels
Elevation labels

Form stereopairs

Point numbers @ With maximum overlap

Coordinate transform ) Al
Display
g"’,‘tel . Control
rientation
Undo Automatically update the scheme if there 1000 Y

are no more images in the project than

Back
ackups Delete empty strips when deleting images

Auto-save
System
Paths

CK l [ Cancel

Fig. 7. Settings of block scheme display
6.2. Parameters of images load and display

The Block scheme | Raster tab is used to setup images display.

- ~
. Parameters @

4 Windows *| [ Raster
Marker (block scheme)
Marker (sterecpair) Load rasters if number of images is less than 20 =
Zoom Load cached images in portions of 10 =
Accelerated transforms
Control ~ | Load non-cached images in portions of 1 =
Madules
4 Block scheme Show source images in zoom greater than 100.00 = %
Raster Cached images transparency D
Stereo
Min Max
Carrelator . .
DEM Maximum cached raster size (may be smaller 512 -
if not supported by video adapter)
TIN
4 Grid [ Transparent background color E
Pathway mode ({for the changes to come into effect, current project must be reloaded)
4 Vectors
Labels
Elevation labels i
[ K l [ Cancel

Fig. 8. Parameters of images load and display

The system allows to setup the following parameters:

13
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» Load rasters if number of images is less than — allows to not display images (just
their frames), if their number in project block is less than specified;

@ In order to display all images regardless of their number choose the Block » Show images

menu item, however this slows down work with images block.

* Load cached images in portions of — allows to set number of cached images during
their loading;

* Load non-cached images in portions of — allows to set number of non-cached
images during their loading;

+ Show true images in zoom greater than — allows to specify a threshold zoom, if
this threshold is exceeded, initial images will be displayed in 2D-window;

+ Cached images transparency — allows to setup a transparency level for cached
images display;

+ Maximum cached image size — allows to specify size in pixels for cached image in
a block scheme;

@ The less the size of the cache, the more quickly the image will be redrawn; the bigger the
size, the higher the shown image quality.

@ Some graphics cards automatically setup the cache size less than maximal.

» Transparent background — allows to set color of transparency of images background.
To set color click the _.. | button and choose necessary color from standard color
palette.

é All changes performed on this tab take effect only after project reload.

7. Stereo settings

The Stereo tab is used to select stereo measurement mode. The system allows to work
in Anaglyph or Page-flipping stereomodes.

& Parameters e

4 Windows ~ | [TSteren
Marker (block scheme) =
Marker (stereopair)
Zoom Anaglyph
Accelerated transforms
Control
Modules

Stereomode

@ Page-fipping

Fig. 9. Stereo settings

14
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8. Correlator settings

For automatic positioning marker on terrain relief in stereo mode the system uses cor-
relation algorithm (see the “Stereopair 2D-window” chapter in “General information”
User Manual and the “Marker modes” chapter in “Vectorization” User Manual).

r 1
. Parameters &J
4 Windows *| | correlator
Marker (block scheme)
Marker (stereopair) Correlation matrix halfsize, pix Increase search area, pix
Zoom X 10 : + 2 :
Accelerated transforms
Control ¥z |10 = X 5 = +X 5 =
Medules ¥ 2 S
4 Block scheme
Raster Correlation threshold 0.9 s Contrast point search area, pix
Stereo
A — | Autocorrelation threshold 30 = X: (20
DEM Minimum mask StdDev 5 = Y: |20
TIN L
4 Grid 1 V| Radiometry from project
Pathway mode Spectral channels
4 Vectors
Labels All similar
Elevation labels RGE
Point r:lumbers @ Average (gray scale)
Coordinate transform
Display Green
Raster
Orientation SR
Undo @ From project data
Backups Within range of 50,000 = from initial approximation
Auto-
uta-save /| Beep on correlation failure
System -
CK l | Cancel

Fig. 10. Correlator settings
The Correlator tab allows to setup the following correlator parameters:

+ Correlation matrix halfsize — allows to specify half size of matrix used to search for
matching points in pixels (default value is 10x10);

é In most cases it is not recommended to increase a size of correlation matrix because it results
in slowing down of images processing.

* Increase search area:

o * X — allows to extend search area by X-parallax (in pixels);

5 Itis recommended to increase this value if during relative orientation points are not embrace
the whole range of heights (if they are not located on highest and lowest relief features).

o *Y - allows to extend search area for matching point by Y-parallax (in pixels).

15
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@ Usually values of Y-parallax not exceed one pixel, that is why increasing of this parameter
leads to decreasing of processing performance without improving processing results.

» Correlation threshold — allows to specify minimal permissible value of correlation
coefficient; points with less value of correlation coefficient will be filtered.

% Decreasing of correlation threshold leads to increasing of number of points found, but raises
probability of errors. Default value is 0.9.

» Autocorrelation threshold — allows to specify maximal permissible value of autocor-
relation coefficient; points with bigger value of correlation coefficient will be filtered;

o [optional] Clear the appropriate checkbox in order not to use the autocorrelation
threshold while filtering points.

The autocorrelation coefficient allows to assess the point uniqueness in the region, which is
determined by the Correlation matrix halfsize.

@ It is recommended to set the threshold between 15 and 30.

* Minimum mask StdDev — allows to specify minimal RMS of brightness using correl-
ation mask (absolutely monotonous surface has RMS that equals 0);

& There is no direct dependence between RMS value and correlation quality, however too low
values indicate that mask mainly consist of “noise”. In most cases it is enough to leave default
value (5). If the image contains only monotonous surfaces, decrease minimal RMS of mask
up to 1. If there are different surfaces or if monotonous surfaces contain too many erroneous
points, specify minimal RMS of mask more than 5.

» Contrast point search area — set this checkbox to allow search for a point with
maximal contrast in specified area (in pixels) prior to correlation.

% It is recommended to increase this value for images with well-defined contours of objects,
and to decrease it for low-contrast (fuzzy) areas, where there is high probability of correlator
errors.

* Radiometry from project— correlator use information about radiometric correction,
obtained from project; set off the checkbox to use source images;

» Spectral channels — allows to choose image spectral channels, using in project
processing:

o All similar — channels, which are similar for all images in the project;

o RGB -red, green and blue channels;

16



PHOTOMOD 8.0 General system’s parameters (Windows x64)

@ Generally, it is selected for tie point calculation on the color images, passed radiometric
correction operation.
o Average (grayscale);

o Green — it is recommended to use for low quality images acquired by compact di-
gital camera.

» Search area - allows to define search area of matching point on the adjacent image:

o From project data — search within maximal and minimal heights, calculated for
each project stereopair;

o Within range of (n) meters from initial approximation — search for a surface
within specified value from marker position.

The Beep on correlation failure checkbox allows to give a sound signal when the
correlator didn’t work.

9. Settings of DEM display

The DEM tab is used to setup parameters of digital elevation model (DEM) display.

. Parameters [&J
4 Windows +| [TbEm
Marker (block scheme) )
Marker (stereopair) Display a
Zoom Texture size U
Accelerated transforms 128x128 4096x4096
Control E —
T Interpolation grid size
Medules 2 e U
4 Block scheme 2 500x500
Raster Palette [E 1 proToMoD palette -
Stereo 7] Hilshading
Correlator . =
DEM arameters B
TIN Angle u 135
4 Grid Level [ 100
Pathway mode
4 Vectors | Marker Z coordinate follows DEM in active layer
Labels =
COK l | Cancel

Fig. 11. Settings of DEM display
In the Display section use sliders to setup the following parameters:

» Texture size — allows to specify texture size, which is used to make surface image
more realistic (to let it look like terrain relief). When the slider is shifted to the right
the image is more detailed, however DEM loading slows down significantly;

17
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* Interpolation grid size — allows to specify a size of regular grid, which is used to
“‘draw on” texture (to comply a relief in non-orthogonal projection), it influences on
DEM display in stereo window.

» Palette — allows to choose the palette for DEM coloring:
o PHOTOMOD palette;
o rainbow palette;
o terrain palette;
o topography palette.

* In the system the Hillshading checkbox is set by default to let your DEM be more
realistic. It is necessary to set off the checkbox to increase performance.

In the Hillshading section use sliders to setup the following parameters:

o Angle — allows to setup lighting parameters (“sun angle”, for example, 90 degrees
- at the nadir; 135 degrees - Northwest lighting);

o Level — allows to specify the level of micro-relief detail (the more the slider is moved
to the right, the more detailed the micro-relief).

* The Marker Z coordinate follows DEM in active layer checkbox is set in the system
by default, the result is that marker is placed on DEM surface, i.e. marker’s Z-coordin-
ate is equated with DEM’s Z-coordinate in specified point of DEM’s active layer.

@ Changes apply for next loaded DEM. To apply changes for active DEM, reload it to the project.

? To get quick access to DEM view settings right-click the name of layer containing DEM in
the Manager. The context menu is opened. Select the Properties item in the context menu.
The DEM Parameters window opens.

10. Settings of TIN display

The TIN tab is used to setup parameters of TIN display.
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r 1
. Parameters [—EhJ
4 Windows - | TN
Marker (block scheme)
Marker (stereopair) /| Color TIN by elevation
Zoom /| Antialiased display

m

Accelerated transforms Display optimization

Control

Display fill instead of triangles for TIM containing more than:
Modules

4 Block scheme 1000000 = points
Raster when window contains more than:
Stereo 50000 |2 triangles
Correlator
DEM Triangulation precsion 0.00 Hm
4 EINd Do not build triangles when layer is created
ri =

COK l | Cancel

Fig. 12. Settings of TIN display

The Color TIN by elevation checkbox allows to display ELLT as grid of triangles colored
by height. If the checkbox is set off all TIN triangles are displayed by the same color,
defined in the Manager panel for TIN layer.

The Display optimization section contains the following parameters used to improve
performance and to display a TIN as solid fill:

* Display fill instead of triangles for TIN containing more than specified number
of triangles;

 Display solid fill for TIN when window contains more than specified number of tri-
angles.

The Antialiased display checkbox is used to smooth TIN and quasi-contours for im-
proving visual perception.

% When TIN is displayed as solid fill quasi-contours are not displayed.

The Triangulation precision parameter is intended for filtering of errors of TIN creation
using vector objects, which contain closely-spaced nodes. A value in the Triangulation
precision field is used to specify minimal distance between points, at which the points
are considered as different nodes, not the same one.

To save computer memory when editing large datasets set the Do not build triangles
when layer is created.

11. Settings of grid display

The Grid tab is used to setup display parameters of regular grid of nodes.
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Use the Display as solid fill when window contains more than ... nodes field to
specify maximal number of nodes, when the number is exceeded the grid will be dis-
played in 2D-window as a solid fill.

' ™y
. Parameters [—EhJ
4 Windows - I Grid
Marker (block scheme)
Marker (stereopair) Cisplay as solid fill when window contains more than 4000 3 cels
Zoom -
OK ] | Cancel

Fig. 13. Settings of grid display
12. Settings of pathway mode

The system allows to create vector objects in pathway mode. Use the Pathway mode
tab to setup parameters of this mode.

r 1
. Parameters [&J
4 Windows - | Pathway mode
Marker (block scheme)
Marker (stereopair) = Set marker Z when jumping to next arid node:
Zoom @ Do not change
Accelerated transforms Z from grid
Control -
Value 0.00 “I'm

Medules
4
Block scheme | Limit grid area in stereopair 2D window
Raster

Stereo 1B Automatically change stereopair

OK l | Cancel

Fig. 14. Settings of pathway mode
Choose one of the ways of specifying marker position by Z when pass to next grid node:

» Do not change — marker position by Z is not change, i.e. Z-coordinate of marker in
previous grid node is used;

« Z from grid — marker position by Z is set equal to Z level of grid, defined in the Grid
properties window;

» Value — marker position by Z is set equal to the value specified in this field (in meters).

The Limit grid area in stereopair 2D-window checkbox is set in the system by default,
that allows to setup passing grid nodes in pathway mode only in borders of stereopair
regardless of grid size.

ﬁ It is not recommended to set the Automatically change stereopair checkbox while the Limit
grid area in stereopair 2D-window checkbox is set, since it leads to work with incorrect data.
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In order to pass nodes of “global” grid with automatic stereopair change set the Limit
grid area in stereopair 2D-window checkbox off and set the Automatically change
stereopair checkbox on. Besides, the Threshold parameter also has influence on
automatic stereopair change. The parameter specifies a distance from stereopair border
in percent of the whole stereopair size, and when this distance is reached during passing
nodes in pathway mode the stereopair is changed to the next one in 2D-window. The
Control tab is used to setup the Threshold parameter (see Section 4).

13. Settings of work with vector objects

13.1. Settings of vector objects display

The Vectors tab is used to setup parameters of vector objects display in 2D-window.

. Parameters [&J
4 Windows | Vectors
Marker (block scheme)
Marker (stereopair) Default curve smoothing 0.30 &
Zoom Points merging radius in topological operations: 10 -6 =
Accelerated transforms
Control Streamline step 10,00 |l
Modules Selection
4 Block scheme | select vertices when marker moves over them
Raster
Stereo | Move marker to selected vertex
Correlator Snapping radius 5 1 pix
DEM )
TIN Snapping
4 Grid Detection radius 100 + pix
Pathway mode |
Snapping radius 10 +| pix
4 |Vectors £ 2
Labels Cache for snapping to coordinates 8 1 pix
Elevation labels Separate 20 and 3D modes
Point numbers =
Coordinate transform Showitk
Display | Show tips
Raster Create common vertices in snap to lines mode
Orientation
Undo Set attributes to default values while object merging/splitting
Backups Deletefadd duplicate vertices while object dosing/undasing
Auto-save ] ]
Join polylines and arcs
System
Pathe Change Z of aligned object
Enable vertex moving of object selected
Display the displacement vector
When replacing a fragment, replace the nearest fragment

K l | Cancel

Fig. 15. Settings of vector objects display
The following settings are available:

» Default curve smoothing — the lower the smoothing coefficient, the more accurately
the curve is created in relation to initial broken line; the coefficient should be set in
range from 0 to 1;
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» Points joint swath for topological operations — allows to specify a distance between
vertices, and if vertices are closer to each other than this distance they are considered
as one common vertex and are edited simultaneously ;

» Streamline step — allows to setup minimal distance in meters during vertices creation
in streamline mode.

The Selection section is used to setup the following parameters of vector objects se-
lection:

» Select vertices when marker moves over them —is used to select a vertex, located
in marker area on a distance specified in the Swath field. For automatic marker move
to selected vertex use the Move marker to selected vertex checkbox;

@ When the vertex is selected the status line displays X, Y, Z coordinates of the vertex and real
marker position;

@ The checkboxes are duplicated by Edit » Select vertices when marker moves over them
and Edit » Move marker to selected vertex menu items.

+ Swath - if the distance (in pixels) from marker to vertex is less than specified the
vertex will be captured during manual selection.

The Snapping section is used to setup the following parameters of snapping (marker
movement mode, when it “sticks” to the different elements of the vector objects on the
screen):

» Detection radius — if marker is placed from the object element at the distance of
less than Detect radius, this element is highlighted by grey colour with no snapping
(moving marker);

@ The Detect radius should exceed the Snap radius.

§ An element of the object is highlighted in gray, if the default Show tips checkbox is not
cleared.

» Snapping radius — if marker is placed from the object element at the distance of
less than Snap radius, a marker snapped to this element. A label of snapping mode
used appears near it;

§ A snapping label appears if the default Show labels checkbox is not cleared.

§ Detect radius and Snap radius are specified in pixels.
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» Cache for snapping to coordinates — determines the number of selected vertices
of the existing objects for snapping to the coordinates stored in the system memory.

+ Separate 2D and 3D modes — allows to create unique combinations of active
snapping options (to points, midpoints, lines, coordinates, as well as perpendicular
mode) separately for 2D and 3D snapping modes.

The Split polygons/polylines section is used to setup the following parameters of
polygons/polylines splitting:

* Delete cutting polyline after the splitting is performed;

» Split only polygons when the both types of objects are intersected by the “cutting”
polyline.

The Create common vertices on snap-to-line mode checkbox allows to add vertices
in snapping mode both on marker and source line height.

@ In the 3D-snapping mode vertices are also becomes topological connected.

The Set attributes to default value while objects merging/splitting checkbox is used
to replace values of objects attributes which are involved in merging or splitting. The
values will be replaced by the following:

* text — blank string,
« float - 0.0,
* integer -0.

§ If an object has obligatory attribute with the same name, its value is used as default value.

The Delete/add duplicate vertices while objects closing/unclosing checkbox allows
to check vertices for duplicates in first or end points. As a result:

* when closing polylines the system checks for duplicates of the first and last vertices,
the last vertex is deleted if necessary;

» when closing polygons the first vertex will be added to the end of polyline.

The Join polylines and arcs checkbox is used to turn on the mode of arc-type CAD-
object joining with the created polyline, as its fragment.

The Change Z of aligned object checkbox allows to connect vector objects in the
alignment mode both on the plane and heightwise.
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The Enable vertex moving on object selected checkbox allows to move individual
vertices of a vector object, even if the entire object was selected before the vertices
editing mode was enabled.

é This function can be useful, for example, when working with cutlines in the GeoMosaic module.

When moving an object, to display a displacement vector as a dashed line between
the first and final marker positions, set the appropriate checkbox.

13.2. Settings of labels display

To setup display of labels of point objects or vertices of linear and area objects the
Vectors | Labels tab is used.

- «
. Parameters L&J
4 Windows “| [Piapes
Marker (block scheme)
Marker (stereopair) | Show object labels
Zaom Display in any zoom when number of objects is less than 10000 5
Accelerated transforms -
Control otherwise display only when zoom is grater than 100,00 | %
Muodules E Shift label relative to point
4 Block scheme ¥ 10 = pis
Raster =
Stereo i 20 w | pix
Correlator Line spacing
DEM 15 & pix
TIN
. Palygons label position
4 (Grid = £
Pathway mode @ In geometric center Inside boundaries
4 Vectors
Labels Labels aligning about objects center
Elevation labels Left @ By center Right
Point numbers i
OK ] | Cancel

Fig. 16. Settings of labels display
The Show object labels checkbox is set in the system by default.
There are the following parameters of labels display:

» Display in any zoom when number of objects is less than specified objects
number;

» otherwise display only when zoom is greater than specified zoom value in percent.

The Shift label relative to point fields are used to specify a value of elevation label X
and Y shift in relation to object center.

Use the Line spacing field to specify spacing between lines in pixels.
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@ If 0 value is input to the shift fields, the label will be placed on top of the point object itself.

The Polygons labels position section is used to choose labels placement - In geomet-
rical center or Inside boundaries of polygons.

The Labels aligning section is used to setup labels placement with alignment by Left,
Center or Right.

13.3. Settings of elevation labels display

In order to setup display parameters of elevation labels of vector objects use the Vectors
| Elevation labels tab.

& Parameters LﬁJ
4 Windows » | [ Blevationlabet
Marker (block scheme)
Marker (stereopair) Label paint objects

Zoom Label vertices of line objects
Accelerated transforms
Control
Madules

4 Block scheme

Raster
Stereo
Correlator Shift label relative to point -
DEM ¥: |-10 | pix
TIN

4 Grid
Pathway mode -

m

| pixc

oK l | Cancel

Fig. 17. Settings of elevation labels display

In order to display elevations of vertices of point vector objects, set the Label point
objects.

In order to display elevations of vertices of linear vector objects (polylines or polygons),
set the Label vertices of line objects.

The system provides the following parameters of elevations display:

* Display in any zoom when number of objects is less than specified number of
objects;

» otherwise display only when zoom is greater than specified value of zoom in
percent.

The Representation accuracy field allows to set number of decimal places for elevation
labels.
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The Shift label relative to point fields are used to specify a value of label shift in relation
to object center by X and Y axes in pixels.

@ If 0 value is input to the shift fields, the label will be placed on top of the point object itself.

13.4. Settings of point numbers display

To setup display of vertices numbers of vector objects use the Vectors | Point numbers
tab.

- -
& Parameters LﬁJ
4 Grid * | | Point numbers
Pathway mode
4 Vectors Highlighted line vertex numbers only on large scales 50,00 H %
Labels. E W -5 1 pix
Elevation labels Shift label relative to point
Point numbers ¥: 10 ~ pix
Coordinate transform -
[ K l | Cancel

Fig. 18. Settings of display of vertices of selected vector object

Set the Number of points of selected line checkbox on to display numbers of vertices
of selected vector object (polyline or polygon).

Use the only in zoom larger than field to specify value of zoom (in percent), and when
the zoom exceeds the specified one numbers of polylines vertices or point objects will
be displayed.

The Shift label relative to point fields are used to specify a value of number shift in
relation to object center by X and Y axes in pixels.

% If 0 value is input to the shift fields, the number will be placed on top of the point object itself.
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1: 3:2 Block scheme
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Fig. 19. Display numbers of vector objects vertices in 2D-window

13.5. Coordinates transformation

The system provides opportunity of object coordinates transformation form one coordin-
ate system to another. The Vectors | Coordinates transform tab is used to choose
transformation method.

r. Parameters

===

4 Grid
Pathway mode
4 Vectors
Labels
Elevation labels
Point numbers

[ Coordinatewanstorm
Transform coordinates between blocks via:
@ pixel coordinates on images

() geodetic coordinates

| Coordinate transform

When transforming georeferenced coordinates between different systems:

Display
Raster
Orientation
Unde
Backups

Ak

m

@ transform via latitude—longitude

() equate numerical values of the coordinates

Use another transform strategy if unable to use the spedfied one

Fig. 20. Settings of coordinates transformation method

The system allows to Transform coordinates between blocks via the following ways:

+ using pixel coordinates on images — is set by default

? This transformation may return incorrect results when using incorrect source data, for example,
blocks of different images or incorrect transformation results of source images.
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» using geodetic coordinates — it is recommended to use if 3D coordinates are asso-
ciated in blocks and one of conditions is performed :

o not all project images have overlap;

o during import data from the different types of projects.

c Selected parameters also have an influence on recalculation between adjustment results of the
same block, so it is recommended to use transformation via pixel coordinates.

Choose the way of recalculation for geodetic coordinates transform between different
systems:

+ transform via latitude-longitude;

ﬁ It is impossible to use this method, if at least one of the blocks is adjusted in free model or
in Cartesian or local coordinate system. During transformation between two adjustments of
the same block, points on images may shift by a value of adjustments difference.

+ equate numerical values of the coordinates — used to equate X,Y-coordinates in
two blocks. The option is used for Cartesian and local coordinate systems, and for
any other cases, except for blocks adjusted in free model.

In order to Use another transform strategy if unable to use the specified one the
appropriate checkbox is set in the system by default. This allows the system to use
optimal way of coordinates transformation. Selected parameters define preferable
method. Set the checkbox off to use only selected way of coordinates transformation.

ﬁ Method of coordinates transformation should be selected for all points of vector file. The system
analyses only possibility in principle to transform by selected method.

13.6. Display settings for vector objects in anaglyphic mode

The system allows you to separately set the colors of vector objects displayed in the
2D stereopair window (in anaglyphic mode).

g In most cases, white is the best possible color for vector objects that are created in anaglyphic
stereovectorization mode (by default).

The choice of other colors, e.g., dark hues, may be feasible in the case of processing images
containing many areas with light hues.

As for both cases described above, it is strongly recommended to avoid red and blue hues, as
well as those close to them.
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f %
. Parameters [—EhJ
4 Grid ~| [o=pay
Pathway mode
4 Vectors In anaglyph mode, display in color
Labels -
[ COK ] | Cancel

Fig. 21. Display settings for vector objects in anaglyphic mode

é All changes performed on this tab take effect only after system reload.

14. Settings of images and DEM load

In order to setup of images pyramid creation during loading of georeferenced images
and DEMs use the Raster tab.

By default pyramids create automatically during images loading. Set the Create overview
pyramids when loading georeferenced images and DEMs checkbox off to turn off
automatic pyramids creation.

§ Created pyramid improves a speed of images refresh.

To skip rasters check for radiometric correction (out of ImageWizard), set the Ignore
missing radiometric correction data when checking rasters.

( . Parameters [-‘IE-T

Marker (stereopair) - I Rast

Zoom
Accelerated transforms /| Create overview pyramids when loading georeferenced images and DEMs

Control Ignere missing radiometric correction data when checking rasters
Modules -

Fig. 22. Settings of images load

15. Settings of orientation

The Orientation tab allows to setup images selection for operation of automatic points
measurement.

In the system by default all block images are selected automatically for points measure-
ment. Set the Select all images for automatic tie point measurement checkbox off
to use for measurement only images selected on block scheme in 2D-window.
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f ™y
. Parameters [—EhJ
Display | | Orientation
Raster
Orientation /| Select all images for automatic tie point measurement
Unde -
OK ] | Cancel

Fig. 23. Settings of orientation

16. Settings of undo parameters

The system allows to undo operations with vector objects, and also to redo recently
undone operations. The Allow undo and Allow redo checkboxes are set on the Undo
tab by default. When working with a fair amount of vector objects using of undo mode
slows down editing operations. In this case set off the checkboxes to speed up the
processing.

Use the Maximum undo steps field to specify number of operations to be saved and
available for roll back. Number of operations by default is 100.

c Itis impossible to undo if too many operations are run automatically. In this case, the appropriate
warning appears, and the list of executed operations is not maintained.

It is possible to undo some operations with DEMs (see The “DEM editing” toolbar in the “DTM

§ List of undo operations is maintained for each layer separately.
Generation” User Manual).

. Parameters [&J
4 Vectors +| [ nde
Labels
Elevation labels /| Allow undo
Point numbers /| allow redo
Coordinate transform . =
i Maximum undo steps 100 |+
Display

CK l | Cancel

Fig. 24. Settings of undo parameters

17. Settings of backups number

The system allows to create backups of project resources. The Backups tab allows to
specify Number of stored backup copies (per resource) for the following types of
data:

« for main project resources;

+ for vector data/ point clouds (including point clouds stored in Windows filesystem).
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If the specified number of backups is exceeded, older backups will be deleted. Backups
of project data are stored in the backup folder of a project. Backups of system settings
are stored in the ProjOption\backup folder of a project.

é If these options values are set to zero, backups will be not created.

- )
. Parameters [&

Orientation “| [ Backups
Undo

Backups
Auto-save - for main project resources 20
System

Paths -

Mumber of stored backup copies (per resource):

-
-
-

- for vector data [ point douds 20

[ oK ] | Cancel

Fig. 25. Settings of number of project data backups

18. Settings of auto-save

The system allows to save vector data automatically. Use the Auto-save tab to setup
the parameters.

i ™y
. Parameters l&
Raster - I Aut
Orientation
Undo Enable auto-saving of vector data
Backups T 5 “ | minutes

Auto-save
System
Paths

4 |.m

OK ] | Cancel

Fig. 26. Settings of auto-save

To use auto-save operation set the corresponding checkbox and setup the following
parameters of auto-save:

* Interval —is used to specify time interval in minutes, to perform auto-save procedure
(in case of user inactivity);

» Disk space limit — is used to specify disk space in gigabytes, reserved for vector
files storing;

* Minimum inactivity period — is used to specify minimal inactivity time, after which
auto-save operation will start.

@ As inactivity is understood to be an absence of the following events: mouse actions, performing
of any operations, windows opening.
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@ In case of overlimit of specified disk space, older files will be deleted automatically at the
system start or during auto-save operation.

Vector data is saved in the PHOTOMODS.VAR\AutoSave folder. A name of resource
with save date is used as a name of vector file during auto-save. Auto-save becomes
possible only after editing of opened vector layers (changed layers are marked by as-
terisk symbol in the Layer manager).

In order to load automatically saved files choose Vectors » Restore. Choose an auto-
saved file in the AutoSave folder to load it into project.

Choose necessary file and click the Open button to load auto-saved file to a project.

19. System settings

The System tab is used to setup system parameters.

-
® Parameters @
4 Windows [ System
Marker (block scheme)
Marker (stereopair) [] Do not use textures for precision raster display =
Zoom
Accelerated transforms [~ Disable raster smoothing @
Control
Modules | compatibility mode when displaying TIN il
# Block scheme
Raster Tile size for reading and displaying images @
Stereo 7 B4x6d @ 128x128 ) 256x256
Correlator
DEM Memory cache buffer for project images @
TIN 200 S| MB
4 Grid - -
Pathway mode Tile size for writing MS-TIFF @
4 Vectors @ 128x128 ) 256x256 ™) 212312 ) 1024x1024
Labels
. Total texture size used for displaying projectimages in the block scheme window
Elevation labels @
Point nurnbers 400 = VB
Coordinate transform .
Display Placement for image preview pyramids
Raster @ Ina Pyramid subfolder 1 In the same folder as base image
Orientation Maximum tile file size within MegaTIFF
Undo =
Backups 1024 + ™
Auto-save It is recommended to define this value between 256 and 2048 MB
System, MegaTIFF DEM i
Pathe ega compression
@ No (O Lzw (O Deflate
Show distributed processing windows
[] alternative progress design
Basic elipsaid parameters
Major semiaxis 6378137.00 5| m @
Minor semiaxis 635675231151 m
Mumber of resources in “recent” menu 10 =
Changes to settings on this page take effect after restarting PHOTOMOD
J

Fig. 27. System settings
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é All changes performed on this tab take effect only after system reload.

The System allows to setup the following parameters:

Do not use textures for precision raster display — allows to speed up images
visualization when working with old graphic cards (the checkbox is set by default);

é When using this parameter positioning with subpixel accuracy is not available (in fixed
marker mode, for instance).

Disable raster smoothing — allows to turn off images smoothing during visualization;

é This parameter influences on accuracy of operations, which use correlator.

Compatibility mode for TIN display — allows to correct TIN display when artifact
appears;

Tile size for reading and displaying images — allows to speed up images visualiz-
ation in 2D-window; the system supports the following tile sizes: 64x64, 128x128,
256x256;

Memory cache buffer for project images — allows to provide system performance
during work with vector data: it is recommended to increase buffer size when working
with not big data volumes or to decrease it when working with vector data of big
volume;

Tile size for writing MS-TIFF — allows to specify tile size of files created in GeoTIFF,
MS-TIFF and BigTIF formats; the system supports the following tile sizes: 128x128,
256x256, 512x512, 1024x1024;

Total texture size used for displaying project images in the block system win-
dow — is used to specify total memory space, allocated for images pyramids in block
scheme;

§ In case of errors of memory allocation after loading of images pyramids, input a value less
than specified by default.

Placement of image overview pyramids — is used to specify path for images pyr-
amids: In a Pyramid subfolder or In the same folder as base image;

Maximum tile file size within MegaTIFF — is used to limit file size included to
MegaTIFF files set. Upper limit of file size — 8 192 MB; file size by default — 1 024
MB.
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é This parameter works for all applications, however it is not recommended to change maximal
file size, when several applications run.

* MegaTIFF DEM compression — cnyxuvT ans orpaHnyeHns pasmepa gansa matpuubl
BbICOT.
o None — no compression;
o Deflate — a lossless data compression algorithm;

o LZW (Lempel-Ziv-Welch) — a lossless data compression algorithm.
ﬁ Some tools of filtering and DEM quick editing using a selection tool may not be available
for DEMs compressed in this way.
It is also possible to make settings of progress windows display on the System tab:

+ Show distributed processing windows — allows to display progress windows during
distributed data processing;

» Alternative progress design — allows to display “cuckoo-clock” in progress window.

The system also provides opportunity to process data of celestial bodies different from
the Earth. For correct work with such projects, specify the Basic ellipsoid parameters
in meters in the Major semiaxis and Minor semiaxis fields. Use the Reset button to
roll back to initial values, calculated for the Earth.

The Number of resources in “recent” menu input field allows to set maximum number
of available recent loaded layers in the Recent submenu of Grid, Points, TIN, DEM,
Contours, and Vectors menus.

20. Paths settings

The Paths tab is used to setup paths.

r 1
. Parameters L&J
Raster » | [TPaths
Orientation
Undo Use custom path for "GIS Panorama™ executable
Backups C:\Program Files\PHOTOMOD _8_x64\MapView11len)
Auto-save -
K l | Cancel

Fig. 28. Paths settings

The Paths allows to setup the following parameters:
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» Set an appropriate checkbox to use custom path for “GIS Panorama” executable
file. Click the _... | button to set this path.

Q This software is not included with the PHOTOMOD but can be installed separately.
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